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Что такое Альфа в ZBrush 

Альфа-текстуры в ZBrush - это изображения в оттенках серого, которые являются своего рода 

трафаретами в работе кистей. Для большего удобства альфу можно представить , как насадку, 

надетую на конец кондитерского шприца. В зависимости от формы получается тот или иной 

узор. Альфа может быть применена к большинству кистей скульптинга. При этом чёрные 

участки изображения будут закрывать для кисти область воздействия, белые - полностью 

отрывать, а оттенки серого давать частичное воздействие, в зависимости от насыщенности 

серого. Альфа имеют глубину в 16 бит, что позволяет более точно кодировать цвет в оттенках 

серого. Настройки альфа можно найти из палитры Alpha, самые популярные из них 

продублированы в палитре левого шелфа (под значком Alpha) - рис.1. 

Рис.1. Палитра Alpha в ZBrush 

 

Альфа-текстуру (по сути картинку) можно перенести из другого редактора, либо создать 

внутри ZBrush 

Создание и настройка Alfa в ZBrush - это процесс многогранный. Есть разные способы и методы. 

Рассмотрим разные варианты: 

1. Для загрузки Alpha с жёсткого диска нужно нажать кнопку Import в палитре Alpha 

2. При создании альфа в стороннем редакторе нужно убедиться, что работа проходит в 16 -

битном документе. Файл PSD нужно сохранять без сжатия. В Photoshop это можно 

сделать через меню Edit → Preferences → File Handling → отметитьDisable Compression 

of PSD and PSB Files 

1. Если появляется ошибка Error encountered while importing a file при импорте 

Alpha: 

1. Для 8 битного изображения изменить пространство на RGB в Photoshop 

(Edit → Mode) 
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2. Для 16-битного изображения изменить пространство на Grayscale  

3. Проверить альфа-канал в каналах Photoshop. Если есть - удалить 

4. Желательно, чтобы нижний слой был отмечен как Background  

2. В Альфу можно превратить любую текстуру. Для этого нужно кликнуть по 

кнопке make Alfa из библиотеки текстур 

3. Из альфа-текстуры можно сделать полноценный 3D-объект. Палитра Alpha → 

субпалитра Make 3D 

1. Mres - плотность сетки создаваемой геометрии 

2. Mdep - глубина (толщина) создаваемой геометрии  

3. MSm - степень сгаженности 

4. DbIS - двойная толщина (зеркальное отображение глубины)  

5. Make 3D - кнопка создания геометрии 

4. Чтобы создать собственную Alfa внутри ZBrush: 

1. Создать геометрию любым доступным способом (см. ниже - вылепить, 

получить из другой альфы и т.д.) 

2. Создать новый документ нужного размера 

3. Вписать геометрию в документ (клавиша F) 

4. Выйти из режима редактирвоания 

5. В режиме рисования сдвинуть изображение в документе с 

зажатой клавишей ~ (тильда/русская ё). Сдвигать нужно вверх, при этом 

изображение затайлится снизу. То же самое можно сделать и сбоку, если 

нужен тайл ещё и по сторонам 

6. Получить Альфу из документа. В палитре альф нажать кнопку GrabDoc 

7. Сохранить альфу отдельно в формате PSD из меню Alfa - Export. Так же 

можно настроить и сохранить кисть вместе с этой альфой, чтобы при 

активации кисти альфа применялась автоматом 

5. Чтобы отредактировать Alpha существует одноимённая палитра (рис.1 справа)  

1. Export - экспортирует альфа в указанном формате на жёсткий диск  

2. Ep - если нажата эта кнопка, то альфа будет экспортироваться в 

модифицированном виде, в зависимости от настроек кривой AlphaAdjust. 

Если не нажата, то экспорт будет в изначальном виде без изменений  

3. Lightbox - Alphas - открывает лайтбокс в подразделе Alpha  

4. Ползунок - выбор нужного изображения из палитры по порядку  

5. R - очищает палитру до текущей выбранной альфа 
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6. Flip H - отражение по горизонтали 

7. Flip V - отражение по вертикали 

8. Rotate - поворот на 90 градусов по часовой стрелке 

9. Invers - инверсия чёрного и белого цвета 

10. Add To Spotlight - добавить альфа-текстуру в спотлайт 

11. To Mesh - конвертировать альфа-текстуру в меш (геометрия выдавлена на 

плоскости) 

12. From Mesh - преобразовать меш на холсте в Альфа. При этом появляется 

окно для позиционирования перед сохранением, где можно выбрать 

разрешение будущего изображения - ползунок Resolution. Для 

большинства простых форм хватает разрешения 512*512. Для более 

сложных форм можно использовать 1024 и 2048px  

 

Рассмотрим группу субпалитр - Alpha ZBrush: 

Субпалитра Create палитры Alpha 

Служит для создания альфа-текстур из генератора шума ZBrush. 

1. Width - ширина вновь созданной альфа-текстуры 

2. Height - высота вновь созданной текстуры 

3. Create From NoiseMaker - открывает окно генератора шума, после настройки и нажатия 

кнопки Ok создастся альфа в указанном выше разрешении  

 

Субпалитра Make 3D палитры Alpha 

Позволяет создавать 3D-геометрию на лету, используя только Alpha  

1. Mres - разрешение сетки новой геометрии 

2. Mdep - глубина погружения в альфу. По сути толщина создаваемой геометрии. Если 

значение стоит 0, толщина будет рассчитана автоматически  

3. MC - Mesh Smooth - сглаженность трёхмерного объекта. Если установлено в 0, то 

поверхность будет построена по принципу кубических поверхностей (состоять из 

кубиков) 

4. DblS - зеркальное отображение модели в глубину 

5. Make 3D - кнопка, которая и создаёт трёхмерную геометрию из Alpha  
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Субпалитра Modify палитры Alpha 

Позволяет различными способами настраивать Alpha 

1. Srteak Lenght - добавляет вертикальные линии шлейфа с обеих сторон Alpha  

2. Density - плотность добавляемых линий, чем выше параметр, тем менее заметны 

отдельные полосы 

3. Intensity - интенсивность полос. Чем выше значение, тем более выраженнее становятся 

полосы по длине, но сама альфа при этом уменьшается  

4. Strength - насыщенность линий 

5. Falloff - спадение (затухание) линий 

6. Noise - добавляет процедурный шум к выбранной альфа, выше параметр - больше шума 

7. Nradius - радиус шума. При увеличении значения шум будет иметь больший масштаб  

8. Blur - добавляет эффект размытия 

9. Max - схлопывает диапазон градаций серого к полностью чёрному или полностью 

белому цвету. Направление схлопывания зависит от изначального цвета  

10. Aa - Anti-Aliasing сглаживание перехода 

11. H Tiles - дублирование альфой самой себя по горизонтальной оси  

12. V Tiles - тайлинг (дублирование) по вертикальной оси. Например, с 

кистью Planar создавать решётчатую геометрию 

13. Surface - автоматическое определение лучшего среднего значения серого цвета на 

выбранной альфе 

14. MidValue - Нужно правильно подобрать среднюю точку: MidValue (обычно 55, а по 

умолчанию 0), если 100 - то белый рассматривается как нулевой уровень смещения и 

весь скульпт будет вдавливаться в модель. Если на 0 - то чёрный рассматривается как 

нулевой уровень и альфа выдавливается на модели. Если 50 - равномерное вдавливание 

и выдавливание одновременно 

15. Seamless - преобразует выбранную альфу в бесшовный узор. Чем выше значение, тем 

менее заметен шов, но и сама альфа будет подвержена большим изменениям  

16. Rf - Radial Fade - увеличение прозрачность к краям альфа  

17. Intensity - увеличение или уменьшение общего значения альфы 

18. Contrast - увеличение контраста для альф, хорошо подходит для уточнения края 

19. AlphaAdjust - кривая регулировки альфы. Изменяет значение интенсивности/глубины 

выбранного альфа-канала от изначально определённого значения  

1. Левая сторона кривой отвечает за тёмные участки (наименьшая интенсивность 

воздействия) 
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2. Правая часть отвечает за самые светлые участки (самое высокое воздействие)  

3. Перемещение кривой вверх усиливает значение, вниз - ослабляет 

1. Чтобы добавить новый ключ на кривую, нужно щёлкнуть по ней ЛКМ  

2. Чтобы заострить средний ключ, нужно вытянуть его за пределы доски и 

вернуть обратно, не отпуская ЛКМ. Чтобы сделать плавным - сделать то же 

самое для острого угла 

 

Субпалитра Transfer палитры Alpha 

1. Make Tx - сделать текстуру из альфы 

2. Make St - преобразовать альфа в Stensil 

1. Для выбранной Alfa в меню альфа вкладки Transfer нажать Make ST  

2. Нажимая на пробел, появится манипулятор для управления шаблоном, подогнать 

шаблон по размеру 

3. В меню Stencil можно настраивать. В том числе видимость альфы - параметр 

Show. Параметр Elv (Elevation) делает трафарет более контрастным для лучшей 

видимости. 

4. Чтобы приснапить шаблон к поверхности меша с её изгибами - функция Wrap 

Mode 

3. Make Modifired Alpha - создаёт новую альфу из текущей на основе модификаций кривой 

с автоматическим добавлением в палитру альф 

4. СС - Clear Color - влияет на поведение кнопки Crop and Fill. Когда кнопка нажата при 

заполнении выбранной альфой холста предыдущая информация будет очищенаё  

5. CropAndFill - обрезает документ под размер активной альфы и заполняет ей холст 

6. GrabDoc - создаёт альфа из информации на холсте (с каналом глубины)  

7. Alpha Depth Factor - интенсивность глубины при создании изображения через Для 

сгенерированных ZBrush альф это значение устанавливается автоматически. Для 

импортированных альфа это значение может быть определено экспериментально. При 

рендеринге объектов с помощью карт смещения, созданных ZBrush, этот ползунок 

отображает оптимальное значение интенсивности смещения 

 

Палитра Brush. Субпалитра Alpha and Texture 

Определяет как конкретная кисть работает с альфа  

1. AlphaTile - тайлинг альфа одновременно по вертикали и горизонтали  

2. Align To Pass - определят насколько точно будет следовать альфа за кистью. Если мазок 

слишком ломаный, то увеличение этого параметра будет уменьшать воздействие альфа, 
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что даст по итогу более заострённую линию в месте крутого изгиба. Меньшее значение 

параметра делает альфа более чувствительной к изгибам кривой и даёт более плавную 

линию 

3. Vertical Aperture - выбранная альфа будет растянута до размера кисти по вертикали 

4. Horizontal Aperture - горизонтальная диафрагма управляет горизонтальным спадом, 

растягивая альфа до размера кисти по горизонтали  

5. PolyPaint Mode - режим покраски 

1. Standard 

2. Colorize 

3. Multiply 

4. Lighten 

5. Darken 

6. Adaptive map size - адаптивный размер альфа под кисть. Чтобы получить полную 

совместимость с кистями, созданными в ранних версиях ZBrush (до версии 4R8), 

значение нужно установить в 0 

7. Magnify Curve - кривая, определяющая увеличение альфа при малом или большом 

давлении стилусом 

1. Low Magnify - если значение выше единицы, альфа будет увеличиваться при 

слабом давлении пером 

2. High Magnify - если значение выше единицы, альфа будет увеличиваться при 

сильном давлении пером 

 

3D Alpha ZBrush 

 

3D Alphas (Vector Displacement Meshes - VDM) 

Создание и настройка Alpha ZBrush - это процесс двусторонний. То есть мы можем не только 

получать геометрию из текстуры, но и наоборот. Причём, сразу создавая кисть для 

полноценной работы в будущем. 

Из альфы можно получить трёхмерную геометрию прямо на поверхности модели. Функция 

работает с кистями Standard, Layer и Chisel 3D. Кисть Layer / Chisel Brush будет производить 

результаты ближе к исходной модели, хранящейся в кисти. Стандартная кисть даст результат, 

более близкий к стандартному 2D альфа  

 

Для создания (лепки) собственной 3D-Alpha: 

1. Загрузить проект из LightBox → Project → Misc → Brush3DTemplate. Модель должна быть 

обязательно построена на 3D Plane с квадратными границами  
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2. Вылепить нужную геометрию на плейне. Нельзя использовать DynaMesh или кисти 

обрезки, чтобы сохранить правильную топологию  

3. Можно использовать Divide для получения нужной плотности. Но не стоит 

злоупотреблять, иначе размер кисти будет непомерно высок  

4. Рекомендуется периодически использовать инструмент смягчения сетки - Tool → 

Deformation → Relax Plane Grid - на нижних уровнях перед углублением в детализацию  

5. Граница модели должна быть идеально прямоугольная. Если края "поплыли", можно 

замаскировать всю внутреннюю поверхность, оставив только плоскость и выровнять 

границы Tool → Deformation → Morph to Grid 

6. Выровнять модель перед камерой прямо (с зажатым Shift), отключив перспективу 

(нужно быть в ортогональной проекции)  

7. Как добавить геометрию в 3D-кисть см. далее 

Для создания собственной кисти с различными 3D альфа воспользуемся 

субпалитрой Create палитры Brush (рис.2): 

Рис.2. Кисти с 3D Alpha ZBrush 

1. Возьмём за основу, например, кисть Chisel 3D 

2. Сдублируем кисть командой Clone 

3. В каждом отдельном сабтуле можно создать собственную модель (имена сабтулов 

будут соответствовать вновь созданным альфа) 
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4. Каждый сабтул должен быть ориентирован в нужном направлении, как будет создана 

альфа 

5. Если нажать кнопку Create MultiAlpha Brush создастся кисть с несколькими альфа - 

каждая из отдельного сабтула 

6. Чтобы добавить один меш к кисти - нажать кнопку From Mesh 

7. Остальные кнопки панели Create используются для копирования, вставки, удаления 

мешей. Копировать альфа 3D можно и между различными кистями  

8. Если модель была основана на плейне, создастся кисть с 3D-Alpha. Если на любой другой 

геометрии, это будет просто кисть с различными двумерными альфа 

9. Кисть можно сохранить Save As из палитры Brush и положить в нужное место на жёстком 

диске 

 


